
  

 

Session 1.3 

The Revit Theory of Relativity: Understanding 
Shared Coordinates 
Paul F. Aubin, www.paulaubin.com  

 
 

Class Description 

Anyone who has used Revit for a while knows that the mere mention of shared 
coordinates always gets the attention of users both new and old. Let's face it, 
Revit's way of handling coordinate systems is unique. But unique doesn’t make it 
any less powerful than other software. In fact, Revit’s approach is quite powerful 
indeed. In this lab we will walk through a few file linking scenarios using Shared 
Coordinates. The goal will be to remove some of the mystery surrounding this 
sometimes baffling topic. We’ll explore common scenarios involving single 
buildings, multiple buildings and how to both set up coordinates and maintain 
them as a project progresses. We won’t cover every possible approach to using 
coordinates in this lab. But we will cover solid and reliable ways to use shared 
coordinates to ensure that your models are always positioned correctly. 
 
 
 

About the Speaker: 

Paul Aubin is the author of many Revit book titles including the widely 
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Introduction 
Before learning Revit, I was a long-time AutoCAD user. As a long-time AutoCAD 
user, I found Revit’s “apparent lack” of coordinates quite troubling. How were 
we ever supposed to place anything precisely when I can’t type in 0,0 
anywhere? Perhaps you shared my experience and frustration? After much self-
inflicted pain and anguish, I have since come to see things the “Revit way” and 
gotten over my “AutoCAD-centric” way of thinking... I am feeling 
much better now... The reality is that while “absolute” 
coordinates may seem comforting in their finality… and well, 
“absoluteness” we do not experience the World this way. In 
“real life” we always have a relative view of the World 
around us. When you are sitting in your office on the tenth 
floor of the building, do you have the perception that 
you are floating high in the air, or rather that you 
are really just sitting in a chair a few feet from the 
floor? Our experiences in the World around us are 
relative. Shouldn’t our design software be too? Well in Revit, as you have no 
doubt discovered, all coordinates, movements, dimensions and measurements 
are always relative to something else. In the topics that follow, we will explore 
the “Revit theory of relativity” (OK, it’s not really called that). If you have let your 
AutoCAD experience ruin you and have just not been able to get your head 
around Shared Coordinates, this session is here to help! 

Revit Origin and Base Points 
Let’s start right in with the question of origin. I am often asked about the origin (or 
0,0) by new users of Revit. So to answer the question: “Does Revit have an origin?” 
the answer is: YES. So the next logical question is, “Where is it?” The simple answer 
is: “It’s in the center of the screen.” Satisfied? No? OK, here is a simple exercise to 
locate it for yourself: 

1. Launch Revit and create a new project from the default template.  

Note: I have used the Autodesk provided: Default.rte template included with the 
US Imperial installation. However, I’ll reference whole numbers wherever possible. 

2. Type VG (or on the View tab, click Visibility/Graphics), scroll down to and 
expand Site and the check (to turn on) Project Base Point and then click OK.  

3. The Project Base Point appears as a round symbol. Select the icon and the 
coordinates of this point will report as 0,0,0 onscreen (see Figure 1). 
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FIGURE 1—TURN ON THE PROJECT BASE POINT USING VISIBILITY/GRAPHICS (VG) 

You will also notice that it is basically in the center of the screen (relative to the 
elevations). There are two alternative ways that you can report coordinate 
locations onscreen.  

4. On the Annotate tab, click the Spot Coordinate tool  
5. Add a spot coordinate symbol to the Project Base Point icon (see Figure 2).  

 
FIGURE 2—ADD A SPOT COORDINATE 

 
There is also the Report Shared Coordinates tool on the Manage tab. 

6. On the Manage tab, on the Coordinates drop-down choose: Report Shared 
Coordinates.  

This command will allow you to click on an object onscreen and it will display the 
coordinates of the point you select on the Option Bar (see Figure 3). 

 
FIGURE 3—REPORTING SHARED COORDINATES 

So now we can see that Revit does in fact have an origin and it is approximately 
at the center of the screen. Feel better now? I thought you might. So if your goal 
was know where the origin is; congratulations. You are done…  
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But, not so fast, there’s more to the story. The real question is: “so what?” “What 
does this 0,0 do for us? Well, at the moment; nothing. Recall that, EVERYTHING in 
Revit is relative. So in order for this Project Base Point that we now have displayed 
to be meaningful, it has to be defined relative to something else. Only then does 
it actually become useful.  

7. Click on the Project Base Point icon.  

Notice that the numerical values that appear to the right of the icon are 
editable temporary dimensions.  

8. Click on and the E/W value and type in a new value such as 20.  

You will actually see the Project Base Point and the surrounding Elevation 
markers appear to shift onscreen. Think of how such an edit would behave 
elsewhere in Revit… For example, imagine selecting a wall and then editing the 
temporary dimension. What would happen? The selected wall would move to a 
new location based on the value you input correct? In other words, the selected 
element moves in relation to the element associated with the temporary 
dimension. If that’s true, then in this case where was the movement measured 
from? Look at the current value of the E/W temporary dimension on the Project 
Base Point. Notice it now reads: 20. But it is still not really clear what the 20 
references.  
Well, Revit gives us another handy reference point for exactly that purpose. The 
second point is called the Survey Point. You can turn it on with VG as well. The 
Project Base Point that we have displayed right now represents some known 
point in our project model. The Survey Point typically represents a “known point 
in the real world.” For example, if you Civil Engineer gives you a survey with some 
established benchmark or known site point, the Revit Survey Point will represent 
this location. This will help you establish the proper positioning of the project on its 
physical site. To see the Survey Point:  

9. Type VG (or on the View tab, click Visibility/Graphics), scroll down to and 
expand Site and the check (to turn on) Survey Point and then click OK. The 
Survey Point is triangular in shape. 

10. Add a Spot Coordinate to the Survey Point if you like.  

By default, both points are in the same location. However, if you are following 
along here and moved the Project Base Point above, you should now have a 
space of 20 units (feet) separating your two points. 
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FIGURE 4—TURN ON THE SURVEY POINT USING VISIBILITY/GRAPHICS (VG) 

If you select the Survey Point, you will notice that the dimensions are not currently 
editable. However, the Survey Point icon CAN be moved; doing so would 
actually shift the coordinate system. This means the new location of the moved 
icon would now be 0,0! Naturally you would want to exercise caution here.  

11. Try dragging the Survey Point onscreen.  

If you still have spot coordinate symbols onscreen, you will see the one on the 
Project Base Point adjust in real-time. Now that we have both points displayed 
and having done this simple experiment, you can hopefully start to understand 
their relationship relative to one another. As noted, the intention of the Survey 
Point is to “anchor” us in the real World. It represents a real and known 
benchmark location on the building’s site (usually provided on the survey). The 
Project Base point is simply a known point on the building itself (usually chosen by 
the project team). Think of the Survey Point as the coordinates in the World and 

the Project Base Point as local building coordinates. For example, The 
Survey Point might be located at the manhole in the middle of the street 
outside the building or on a utility pole, while the Project Base Point might 
be at the front door or column line intersection A1. You can choose the 

point that is most convenient to the project team. What is important is NOT 
specifically where the two points are, but rather their relationship RELATIVE to 

one another. This is what we mean by Shared Coordinates in Revit. 
Specifically, the Survey Point is a known point in the Shared Coordinate 
System. It is called the Shared Coordinate System because it represents the 
coordinate system of the World around us and is therefore “shared” by all 

buildings on the site. The Survey Point defaults to the origin (0,0,0) of the Shared 
Coordinate System, but you can move it to ANY convenient point for your 
project. There are a few ways to do this.  
Likewise, the “Internal Coordinate System” of your building is the building’s 
“local” coordinates which are typically oriented perpendicular and parallel to 
something meaningful in the building. For example, if the building has a 30° 
rotation on the site, it is much more convenient to work on the building 
horizontally and vertically with respect to your screen, the building’s major 
architectural elements and the plotted sheets, rather than at 30°.  
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This is referred to as the local  
Internal Coordinate System and “Project North.”   

 
FIGURE 5—VISUALIZING THE RELATIONSHIP BETWEEN INTERNAL AND SHARED COORDINATES 

The existence of both coordinate systems lends meaning to the other. If we did 
not have both, we would be forced to assign arbitrary meaning to coordinate 
system and its origin and force the building to match the survey or vice/versa. 
The Revit system allows us to keep both! And more importantly, it allows both to 
have real-world meaning. 

Project Location Tools 
As noted above, the Project Base Point and Survey Point can be moved. In other 
words, while they are located at the origin by default, they do not have stay 
there. There are a few ways to move them. You can move the point icons 
themselves directly onscreen using the Move tool or temporary dimensions (as we 
have already seen). There are also some commands on the Manage tab. Moving 
the points onscreen offers results similar to these commands depending if the icon 
is clipped or not. (Click the small paperclip icon to clip or unclip) Let’s look at 
each option and command.  
 Position>Relocate Project—This command moves your 

project relative to the Shared Coordinate System. You 
can use it in plan or elevation views and it works just like 
the Move command; you first click a start point, then a 
new point. The result will be a change in the numerical 
offsets reported by the Project Base Point and is basically 
identical to the result achieved above by editing the temporary dimension of 
the clipped Project Base Point.  
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 Position>Rotate True North—This command changes the orientation of True 
North relative to the orientation of the building. (Revit understands both True 
North; North with respect to the actual site and Project North; “up” relative to 
the screen (or plotted sheet) and usually set parallel or perpendicular to 
major building geometry). To use this command, you must be in a plan view 
and the plan view must have its Orientation parameter (on the Properties 
palette) set to: True North. It behaves just like the normal Rotate command 
but the result impacts the orientation of the entire building relative to the site. 
After rotating True North, you can see the results on the Project Base Point 
and Survey Point icons (see Figure 6).  

 
FIGURE 6—ROTATE TRUE NORTH IN A PLAN WHOSE PROPERTIES ARE SET TO TRUE NORTH 

Note: You can also rotate True North by using the temporary dimension on the 
Project Base Point icon. This method does not require that you first change the 
orientation of the plan view.  
 Position>Mirror Project—This command mirrors (flips) the project with respect 

to the Shared Coordinate System. Please note that all aspects of the project 
“flip”. So if you flip left to right and you started with an elevation on the right 
named East, the elevation that ends up on the right following this command 
will be named West! (I recommend avoiding this command if at all possible).  

 Position>Rotate Project North—After adjusting coordinate systems, sometimes 
the plans and other views don’t fit as nicely on the sheets. For example, if your 
building is much taller than it is wide, you might wish to rotate Project North. This 
offers several pre-sets like rotate 90° or 180°. You can also rotate arbitrarily if 
necessary. You can easily avoid this command by planning your building 
orientation to match the proportions of your monitor and/or plotted sheets. 
Project North and Project Base Points are meant to be convenient. Don’t make 
you work harder by assigning unnecessarily complex meaning to these items. 
Keep it simple. With a little pre-planning, you will rarely need this command.  
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 Coordinates>Specify Coordinates at a Point—This command allows you to 
click on an object at a point, an edge or a surface. You can also click on 
your Survey Point with this command. A dialog will display with editable fields 
where you can input known values for the selection you made. You would 
acquire appropriate values to input from your survey file or Civil Engineer. 
Using this command, you can achieve the same results as most of the  
other commands listed here but in a single step. In most cases, this is the  
most reliable way to establish your “real-world” coordinates (see Figure 7).  

 
FIGURE 7—USE SPECIFY COORDINATES AT A POINT TO INPUT EXACT WORLD COORDINATES 

 Coordinates>Report Shared Coordinates—This command was mentioned 
above. Use it to get a read out (on the Options Bar) of any point on a 
selected element onscreen. The read out will display the Shared Coordinate 
values for the selection.  

Let’s try Specify Coordinates at a Point. This command is helpful when you get 
coordinate information from your Civil Engineer.  

12. On the Manage tab, click the Coordinates drop-down and choose: Specify 
Coordinates at a Point.  

13. Click directly on the Survey Point icon (triangle) and then input values for N/S 
and E/W. Any value is fine such as: 50 and 100.  

Notice how the Survey Point moves off screen (lower left) and the coordinates of 
the Project Base Point adjust in response.  

14. Zoom in on the Survey Point.  

Notice that is still reads 0,0. It moved off screen and stayed at 0,0 because it is 
still clipped. The result is different if you unclip.  

15. Undo the last change 
16. Select the Survey Point icon and then unclip it (see Figure 8). 
17. Repeat the Specify Coordinates at a Point command. Use the same numbers. 

Notice that this time the Survey Point stays in the same location, but its 
coordinates change to match our input. The Project Base Point also adjusts. 
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FIGURE 8—CLIPPED AND UNCLIPPED ICONS BEHAVE DIFFERENTLY 

Understanding Location 
So far we have limited our discussion to just a single file. What happens with 
coordinates when you begin linking other files (CAD or Revit) into the current 
file? This is where Shared Coordinates really gains its fullest value. Since Revit 
understands the notion of a global (or World) coordinate system, it is pretty easy 
for us to “share” this coordinate system with more than one project. All of the 
projects will “share” the same basis for their positioning in the World—thus the 
name “Shared Coordinates.” To fully understand the concept, let’s introduce 
another new concept called: Location and Shared Sites.  

 
FIGURE 9—ACCESS THE “LOCATION WEATHER AND SITE” DIALOG IN SEVERAL WAYS 

To fully describe where an object sits in 3D space (its location), we need three 
dimensions East/West position (X coordinate), North/South position (Y 
coordinate) and elevation (Z coordinate). We also need the rotation angle East 
or West of True North. These four bits of information uniquely position our building 
on the site and with respect to a known benchmark and other buildings. Further, 
we can assign a unique name to the collection of these four bits of data. This 
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named collection of coordinates is referred to in Revit as a: Shared Site. To 
manage our Shared Sites, we use the Site tab of the “Location Weather and 
Site” dialog. To get here, you can use the Location tool on the Manage tab, and 
then click the Site tab. Alternatively, you can access the Site tab directly from 
the Survey Point icon or from the Shared Site item on the Properties palette when 
a linked file is selected (see Figure 9).  
A Shared Site is how we describe where our building sits and how it is oriented on 
the property. A project CAN have more than one Shared Site saved in the 
“Location Weather and Site” dialog. By default, each project has only one 
Shared Site which is named: “Internal” by default. This name simply describes the 
fact that the default for any project is its “internal” local coordinate system. As 
you begin to save Shared Sites, it is highly recommended that you name them 
more descriptively.  
In many situations, you will only require a single Shared Site for each project file, 
however there may be situations where multiple Shared Sites are appropriate 
and desirable. For example, in a condominium development, the same building 
design may be sited multiple times in a subdivision. You could use a single Revit 
file and copy the link multiple times. Each copy would be given its own Shared 
Site thereby allowing each instance of the linked file to have its own unique 
location in the larger Shared Coordinate system.  

 
FIGURE 10—VISUALIZING MULTIPLE SHARED SITES IN A SHARED COORDINATE SYSTEM 

Scenarios 
There are potentially many ways that you can set up any given project. There 
are also several tools and a few approaches available to approach the setting 
up of Shared Coordinate systems. We have discussed many tools, but for a little 
more hands-on look, I have chosen two simple scenarios.  
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 Scenario 1—a single pair of files. (For example one building on its property) 
 Scenario 2—a multi-file setup. (For example a single property with many 

buildings) 

Scenario 1—A Single pair of files 
In this scenario, we assume two project files that need to be linked together. 
(However this process would work nearly the same with linking CAD files, but for 
simplicity here, I will only be discussing Revit linking). The essential process is 
simple. Create each project file with an orientation and location that is 
convenient and logical for THAT file. Do not choose a location, origin or 
orientation based on the site file or any other building in the campus. Remember, 
everything in Revit is relative. So determine the best orientation and location for 
the project file you are in and then use that orientation and location to build your 
model. In other words, convenient for the project team, i.e. perpendicular and 
parallel to the screen and the sheets. I have provided a very simple file.  

1. Open the file called: Simple Building.rvt. 
2. Open the Site plan view. 

This file was created with the default template and the two site points are 
already displayed in the Site plan view and both occur at the origin.  

3. On the Insert tab click the Link Revit button and locate the Terrain.rvt file.  

For each pair of files that you link, you have to perform the basic setup. That 
means that the first time, you can choose any option you like for Positioning. I 
recommend just using Auto – Center to Center. We will be repositioning in the 
next step.  

Tip: Again, this is the place where it is best to forget about the AutoCAD past 
and just focus on the “Revit way” to do this. In other words, though you are 
tempted to use Origin to Origin (which is the default in 2016), it is often not the 
best option when linking a building to its site. Origin to Origin is best when linking 
between disciplines. For example, linking the MEP or Structural files to the 
Architectural.  

Next you will move and/or rotate the linked file into the correct relative position.  
The most important thing to remember in this step is that we will not be moving 
the building geometry, but rather we will be moving the linked terrain model. 

4. Select the linked file, and move it down 30 and then to left 15. 
5. Rotate the file 20°. 
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This positions it in plan, but we also need to position it in the vertical direction in 
an elevation view. 

6. Open the South elevation and using the Align tool, align Level 1 in the linked 
file with Level 1 in the host (see Figure 11).  

 
FIGURE 11—POSITION THE LINKED FILE CORRECTLY RELATIVE TO THE BUILDING 

Finally you will save the Shared positioning and assign it to a Shared Site. There 
are a few ways to do this.  

7. Open the Site plan view.  

Notice that both site points are currently at 0,0.  

8. On the Manage tab, click the Coordinates drop-down and choose: Acquire 
Coordinates and then select the linked Terrain file.  

Notice how the Survey Point moves.  

9. Select the Survey Point, note its orientation and coordinates and then select 
the Project Base Point and note its coordinates (see Figure 12).  

 
FIGURE 12—USING THE ACQUIRE COORDINATES TOOL 

That’s it. But the most important step is to save.  

10. Save the current file.  

Since we used “Acquire,” this host file adopted the coordinate system of the 
linked terrain file. Once you have established the relationship, Revit will maintain 
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it for you. You can open the other file and link in reverse, this time choose the 
Auto – By Shared Coordinates option and the file will know exactly where to go!  

11. Close the current file and then open the Terrain.rvt file. Open the Site plan view. 

Since we acquired coordinates above, this file remains unchanged. It still has 
both Project Base and Survey points in the middle of the screen. Note also that 
the orientation of the terrain is parallel to the screen.  

12. Link the Simple Building.rvt file. This time, for Positioning, choose: Auto – By 
Shared Coordinates (see Figure 13) 

 
FIGURE 13—LINK USING SHARED COORDINATES 

Notice that the file went to exactly the right location and orientation (see Figure 14).  

 
FIGURE 14—WHEN USING THE ACQUIRE COORDINATES TOOL, THE SHARED SITE DEFAULTS TO INTERNAL 

13. Select the building linked file onscreen. Note the name of the Shared Site on 
the Properties palette.  

Since we used the Acquire Coordinates tool, Revit simply used the default site 
which is typically named: “Internal.” For a simple pair of buildings like these here 
in this example, this is perfectly suitable. However, I prefer to rename the Internal 
site to something more descriptive. Of course this is completely optional. Rather 
than rename it now, we will look at naming the sites in the next scenario. For now 
this completes the basic setup. So when linking two files bi-directionally,  

14. Close any open files.  

Set up Shared Coordinates from the Properties palette 
Using the Acquire Coordinates tool is a quick and easy way to set up the shared 
coordinates. However, when you want to change the defaults, (such as 
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modifying the shared site that is used), you can use the Properties palette to 
establish your shard coordinate setup instead.  

1. Open the Building A.rvt project file. (Make note of where the Project Base and 
Survey Points are). Close the file without saving. 

2. Open the Terrain (Start).rvt project file. 
3. Open the Site (Project North) plan view and then Link in the Building A project 

using: Auto – Center to Center.  
Note: If you forget to change the Positioning, Revit will warn you that the two files 
do not share coordinates and use Center to Center anyhow.  
The building will link in too low and appear below the terrain. Only the two grid 
lines in the file will show in this view. Open the South (Full) elevation view to see 
and move the file vertically. 

4. Move and/or Rotate the Building linked file to make the building sit properly on 
space provided in the Platform 1 view. Align works well for this. Use girds A and 
1 in plan and the Platform 1 level in elevation.  

Let’s look at an alternative way to establish the shared coordinates.  

5. Select the linked file and on the Properties palette, next to Shared Site, click 
the <Not Shared> button (see Figure 15).  

 
FIGURE 15—ON THE PROPERTIES PALETTE CLICK THE SHARED SITE BUTTON  

In the “Shared Coordinates” dialog that appears, you will be given the option to 
either Publish or Acquire the coordinates. There is a description of each option in 
the dialog that appears. What it essentially boils down to is that you are 
synchronizing the Shared Coordinate System between the two files. In other 
words, before this command, the two files know nothing of each other’s 
coordinates. After the command, they will SHARE the same coordinates. So, 
which file’s current coordinate system do you want to use for both files? Do you 
want the current host file to share its system with the linked file? Or would you 
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prefer the linked file to share its system with the host? Typically I like to let the site 
file’s coordinates to become the overall Shared Coordinates. So in this case, 
since I am currently in the Site project and it is hosting the Building project, I 
would want to “Publish” the coordinates to the Building project (replacing its 
Shared Coordinate system and making it match the site host file). Please note 
that regardless of which option you choose, NO changes are made to either 
file’s local internal coordinates. What we are doing right now is simply recording 
how we want the two files to coexist physically in 3D space.  

6. Choose the Publish option.  

You could simply click the Reconcile button here to complete your choice. This 
would use the default site name: Internal as we did above. However, as noted 
above, I highly recommend that you take the additional step of renaming or 
copying the Shared Site.  

7. In the “Share Coordinates” dialog, next to Building A.rvt: Internal (as the 
bottom), click the Change button.  

This opens the “Location Weather and Site” dialog to the Site tab. You can 
Duplicate or Rename the default shared site here. If you only require one shared 
site, simply rename it. Otherwise, choose Duplicate. Choose a good descriptive 
name. You are describing the building’s location on the site here. “Preferred 
Site,” “Alternate A” or “North Quadrant” are some examples. In this case, we’ll 
call it: Platform 1.  

 
FIGURE 16—CHANGE THE SAVED POSITION AND RENAME IT MORE DESCRIPTIVELY 

15. Rename the site to: Platform 1 and then click OK. Back in the “Select Site” 
dialog, click the Reconcile button.  

16. Finally as before, to make all the changes “stick” we must save. Click the Save 
icon on the QAT (or press CTRL + S). 

Above we only needed to save the host file. This was because we acquired the 
coordinates. In this case, we are publishing the coordinates. This means that we 
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are changing the linked Revit file. So we must actually save both files. A dialog 
will appear to enable you to do this.  

17. In the “Location Position Changed” dialog, click the Save option at the top.  

 
FIGURE 17—SAVING ALSO PROMPTS YOU TO SAVE THE LINKED FILE AND ITS SITE(S) 

The first option: Save is the only good choice. If you choose either of the other 
two options it negates the changes you have made. So neither is a good 
choice. The final step is to test what you have done. You can do this by opening 
the other file and linking again. (You cannot have both projects opened at the 
same time, so close the current project first).  

18. Close the Terrain (Start).rvt project and open the Building A project.  

Notice that the Project Base Point and the Survey Point are now offset from one 
another. Notice also if you click on them or query their coordinates that the 
values reflect the changes made in the other file. If you open the Level 1 plan 
view, you will notice that the building file remains oriented horizontally and 
vertically relative to the screen (see Figure 18). 

 
FIGURE 18—OPEN THE LINKED FILE TO SEE THE RESULTS 
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19. Link in the Terrain (Start) file. This time, choose: Auto – By Shared Coordinates.  

Notice that the site file comes in exactly in the correct location and orientation. 
Part of the beauty of Shared Coordinates is that you only need to set them up 
once. From then on, both files will “know about” each other. So now we have 
two methods to set up a pair of files. In the next sequence we will some add 
additional files to make a more complex setup.  

20. Close and save all files.  

Scenario 2—A Multi-File Project 
A multi-building project typically has a single site file with many buildings on it. 
Each building might be a separate Revit project, or you may also find the need 
to use the same Revit model in more than one location on the site (this was 
mentioned briefly above).  
A multi-file project includes the same considerations as a single building project 
but has the extra added complexity of coordinating multiple building models with 
respect to one another. Each pair of files is set up the same way as above. The 
difference is that, the Shared Coordinate System is now shared amongst ALL the 
files, not just the pair. Therefore, you should consider carefully which file you wish 
to execute the process from. In most cases, the Site file will be the obvious choice. 
But this is not required. Let’s look at an example with some VERY simple files.  

Siting copies of the same linked file 
Establishing multiple shared site locations can be very useful. There are two basic 
scenarios: the first involves using more than one copy of the same project file on 
the site (this was mentioned above with the example of a condominium layout). 
The other scenario is the establishment and saving of alternate site locations for 
a single building. The set up process for either scenario is similar.  

1. Reopen the Terrain (Start) file, select the linked file, copy it to a new location.  
2. Adjust the positioning of the file (Move, Rotate or Align) as required to place it 

at Platform 2.  
3.  Select the copied linked file. On the Properties palette, note that the Shared 

Site is reset back to <Not Shared>. Click this button.  
4. In the “Choose Site” dialog, choose the “Record current position” (second 

choice) radio button and then click the Change button.  
5. In the “Location Weather and Site” dialog, click Duplicate and name the new 

site: Platform 2.  



The Revit Theory of Relativity: Understanding Shared Coordinates  
Paul F. Aubin, www.paulaubin.com 

  

 Page 18 of 24 

6. Click OK twice to dismiss the dialogs and save the file (see Figure 19).  

 
FIGURE 19—COPY A LINKED FILE AND THEN DUPLICATE THE SHARED SITE TO MAKE IT UNIQUE 

You may have noticed that this time we were not asked to publish or acquire. 
This is because the relationship between the host and link is already 
established—the two files already share a coordinate system. Here we are simply 
establishing a second location within the current shared coordinate system. You 
can only use each saved shared site locations one time. So if you make three 
copies of the file, you will need at least three named sites. You can have as 
many named sites as you like. If you need multiple copies of the building on the 
site (like the condominium example) you are finished. We now have two copies 
of Building A on the site each in its own named location. Let’s see how that 
works back in the Building A file.  

7. Close and save the Terrain (Start) file. You will be prompted to save Building A 
again. Be sure to click Save.  

8. Open Building A and then open the Site plan view.  
9. On the Properties palette, change the Orientation to: Project North.  

Note how the building is now oriented to match the screen. However, notice 
that the site is still oriented as if the building were at the Platform 1 location.  

10. On the Manage tab, click the Location button. In the “Location Weather and 
Site” dialog, click the Site tab.  

Notice the two Sites with the names you assigned. One will have the label 
(Current) next to it. This is the currently active Site location.  

11. Select Platform 2 and then click the Make Current button. Click OK.  

Remember our basic thesis in this class? It’s all relative. Notice what has 
happened. Since we are in the building file and looking at a view that is set to 
Project North, the building orientation and location is unchanged. What 
happened is that the linked terrain file adjusts as required to show us the correct 
position relative to the now current Platform 2 location! Very cool! 
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Siting multiple linked files 
The previous example is how you would set up the condominium example noted 
above. If instead, you want to be able to consider the same building at different 
locations on the site, we can simple delete the copied instance of Building A 
and then we are free to move the remaining instance to either the Platform 1 or 
2 site—as long as it is not currently in use.  

1. Close and save Building A and return to the Terrain (Start) file.  
2. Delete the instance of the linked Building A file at Platform 2. 
3. Select the other linked file and on the Properties palette, click on the button 

next to Shared Site (it will be named Platform 1).  
4. In the “Choose Site” dialog, click the Move instance to radio button (at the 

top) and then choose: Platform 2 from the list.  
5. Click OK to see the results (see Figure 20).  

 
FIGURE 20—MOVE AN INSTANCE OF A LINK TO A DIFFERENT SHARED SITE 

Notice how the building moves to the other location and orientation.  

Multiple Buildings 
Now let’s add a few more buildings.  
1. In Windows Explorer, make a copy of the Building A file and name it: Building 

B. Open it and change the geometry a little. (Since this is just model text, 
change the text to: B) and then close and save the file.  

Now let’s link the new file. Since you copied it from the original, it will already 
have the same shared coordinates and the two saved sites. (A copy of the file is 
included called: Building BB if you want to skip the previous step).  
2. Link the copied file into the Terrain (Start) project.  
3. Use: Auto – By Shared Coordinates. 
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The “Location Weather and Site” dialog will appear displaying the two saved 
sites. Notice that one of them will be labeled as (Current). This is the site that you 
chose as current when you last had this file open. It does not matter which is 
current, you can choose either one when linking (see Figure 21).  

 
FIGURE 21—WHEN THERE IS MORE THAN ONE SITE IN THE FILE, YOU ARE PROMPTED TO SELECT A SITE 

4. Choose the site that does not currently have a building on it and click OK.  

You can repeat this process as many times as you need to. Copying and 
renaming the file in Windows Explorer is convenient early in the project before 
any building geometry is established. However, if this is not practical, simply link 
an existing file instead (not a copy). You will then have to repeat the steps 
above to establish the shared coordinates the first time. Remember, each pair of 
files must have the initial setup performed the first time. From then on, you can 
use By Shared Coordinates in linking either file.  

Cross Linking 
At this point you have a Site, and Building A and Building B. One of the biggest 
benefits of this whole process is that all three of these files all share the same 
coordinates. So you can link Building A to B and vice versa without doing any 
further setup! 
5. Close the Terrain (Start) project and open Building B.  
6. Link in Building A By Shared Coordinates.  
7. When prompted choose your preferred site.  

Very cool! 
 
You can take it a step further by adding multiple sites to each 
file. Then you can select any one of the links, click the Shared 
Site button on the Properties palette and move it to a different 
site. In this way you can try different siting options for each 
building on the site (see Figure 22).  
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FIGURE 22—MAKE ADDITIONAL COPIES AND TRY DIFFERENT SITING OPTIONS 

Maintaining your Coordinates 
I’d like to address two final topics. First, what happens when the coordinates 
change, and second how to ensure that they export to other programs properly.  

Changing a saved location 
It is best practice to set up your links and there coordinates and saved sites as 
early in the life of the project as possible. But that does not mean that the setup 
can’t or won’t change as the project progresses. It is pretty easy to manage 
changes to your saved coordinates. But you need to save the change to both 
file. Think of it this way: saving shared coordinates is establishing a relationship 
between two files. Therefore, if something changes, it will naturally affect the 
relationship. So both files need to be saved to conform to any changes in 
location. Perhaps the biggest issue here is what to do when you do not have 
access rights to both files to make the change. In such a case, you will need to 
coordinate with the owner of the other file to ensure that the new positions are 
saved.  
To see how it works, simply move one of your linked files. You will immediately be 
alerted that the change affects the shared coordinates and be offered to save 
the change. You can click the Save Now button to save immediately, or click 
OK to postpone. Later you can open Manage Links to save the positions. Also 
when you save the host file, you will be prompted to save the link file as well. So 
regardless of when you execute the save action, Revit will be quite insistent that 
you do save, otherwise it will disable the shared coordinates.  
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FIGURE 23—WHEN MOVING A LINKED FILE, YOU MUST RESAVE THE SHARED POSITIONS 

Exporting Shared Coordinates 
If you export your Revit project with shared coordinates to CAD or Navisworks, 
there is an important setting to ensure that correct coordinates are saved with 
the exported file. In both cases, you want to make sure that you are exporting 
Shared coordinates and not Project Internal. The settings are configured as you 
export.  
 Export to CAD—You can get to the CAD export options from the Application 

menu. From the Application menu, choose: Export > Options > Export Setups 
DWG/DXF. In the “Modify DWF/DXF Export Setup” dialog, you can edit the 
current setup or create a new one. Click on the Units & Coordinates tab and 
click the Shared radio button. Click OK to complete the setup (see Figure 24).  

 
FIGURE 24—CHOOSING TO EXPORT SHARED COORDINATES TO CAD 

 Export to Navisworks—From the Application menu, choose: Export > NWC. In 
the “Export scene as” dialog, at the bottom, click the Navisworks settings 
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button. In the “Navisworks Options Editor”, click the File Readers > Revit option 
on the left, and then for Coordinates, choose: Shared (see Figure 25).  

 
FIGURE 25—CHOOSING TO EXPORT SHARED COORDINATES TO NAVISWORKS 

 
Please feel free to experiment further. Thank you for attending.  
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Further Study 
You can find more information and tutorials in my books and video 
training. Please visit my website at: www.paulaubin.com for more 
information on my books.  
I also have Revit video training available at: 

www.lynda.com/paulaubin. I have several courses at lynda.com 
including: Managing Location Coordinates with Revit. This course 

explores many of the same topics covered in this paper and 
session. In addition, you can check out my other courses like: 
Revit Essential Training, Revit Family Editor and Revit 

Architecture Rendering, Advanced Modelling in Revit 
Architecture, Formulas and Curves and many more. 

If you have any questions about this session or Revit in general, you can use the 
contact form at www.paulaubin.com to send me an email.  
Follow me on twitter: @paulfaubin 
 
 
 
In addition to my books and videos, there are many other resources available 
online, in blogs, books etc. My good friend Steve Stafford (also a speaker here) 
has a very popular Revit blog at: http://revitoped.blogspot.com  
 
He has also taught on the subject of Shared Coordinates and his paper on the 
subject is well worth a read. You can find it posted here: 
http://revitoped.blogspot.com/2012/05/shared-coordinate-post-summary.html  
 
Another useful resource is recorded classes at Autodesk University. This one by 
David Baldacchino is quite good: 
http://au.autodesk.com/au-online/classes-on-demand/class-catalog/2013/revit-
for-architects/ab1412  
 
Thank you for attending. Please fill out your evaluation.  
 

 


